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1. INTRODUCTION  TO  ATL

ATL is the Active Template Library, a set of template-based C++ classes with which we can easily create small, fast Component Object Model (COM) objects. using ATL, we can create efficient, flexible, lightweight controls. 

Using a Template Library :

A template is similar to a macro. As with a macro, invoking a template causes it to expand (with appropriate parameter substitution) to code 

we have written . template goes further than this to allow the creation 

of new classes based on types that we pass as parameters. These new classes implement type-safe ways of performing the operation expressed

in your template code.

Template libraries such as ATL differ from traditional C++ class libraries in that they are typically supplied only as source code (or as source code with a little, supporting run time) and are not inherently or necessarily hierarchical in nature. Rather than deriving from a class to get the functionality you desire, you instantiate a class from a template.

The Scope of ATL :

ATL allows you to easily create COM objects, Automation server & ActiveX controls. ATL provides built-in support for many of the                     fundamental COM interfaces.

ATL is shipped as source code which you include in your application.  
ATL also makes a DLL  available ( atl.dll ) , which contains  code   
that may be shared across components. this DLL is not neceessary.

Choosing When to Use ATL

When developing components and applications, you can choose between 

two approaches  — ATL and MFC (the Microsoft Foundation Class Library).

Using ATL

ATL is a fast, easy way to both create a COM component in C++ and maintain a small footprint. Use ATL to create a control if you don’t need all of the built-in functionality that MFC automatically provides.

Using MFC

MFC allows you to create full applications, ActiveX controls, and active documents. If you have already created a control with MFC, we may 

want to continue development in MFC. When creating a new control, consider using ATL if you don’t need all of MFC’s built-in functionality.

2.Creating ATL Project 

Using the ATL COM AppWizard

To create a project using the ATL COM AppWizard 

1. Open Visual C++. Click New on the File menu and click the Projects tab.


2. Choose ATL COM AppWizard as your application type.


3. Enter a project name.


4. Click OK. 


The ATL COM AppWizard displays a dialog box showing options that apply to your ATL project: 

· Choose from one of three server types: Dynamic Link Library (DLL) for an in-process server, Executable (EXE) for a local out-of-process server, or Service (EXE), which is a Windows NT application that runs in the background when NT starts up. 


· Select the Allow merging of proxy/stub code check box as a convenience when marshaling interfaces is required. This option places the MIDL generated proxy and stub code in the same DLL as the server.


· Select the Support MFC check box (available for DLL projects only) to use MFC functionality (such as CString) in your server.


· Select the Support MTS check box to modify the project build settings to support the Microsoft Transaction Server.

Files Generated by the ATL COM AppWizard

Choose the FileView tab in the Project Workspace and expand by clicking + to see the files generated for your project:

Test.cpp                   Contains the implementation of your DLL’s exports for an in-process     

server and the implementation of WinMain for a local server. For 

 a service, this additionally implements all the service managemet        functions.

Test.def                   contains a list of your DLL’s exports. Generated only for an in-process                              

                             server.            

Test.idl                   Includes the definitions for all your interfaces. As an Interface Definition              

Language (IDL) file, it will be processed by the MIDL compiler to          generate  the Test.tlb type library and marshaling code.      

 Test.rc                   Contains the resource information for your project.

Resource.h              The header file for the resource file.

StdAfx.cpp              Includes the files StdAfx.h and Atlimpl.cpp.

StdAfx.h                 Includes the ATL header files.

Adding Objects and Controls

You can use the ATL Object Wizard to add an object or a control to your ATL or MFC-based projects. For each COM object or control you add, the wizard generates CPP and H files, as well as an RGS file for script-based registry support.

If you are attempting to add a simple COM object to an MFC project, you will need to add ATL support to the existing project.

To add an object or a control using the ATL Object Wizard 

· With your project open, select New ATL Object from the Insert menu. 

· or-

· From ClassView, click the right mouse button on the project-level folder, and select New ATL Object from the pop-up menu. 

The ATL Object Wizard opens.

he ATL Object Wizard displays the categories of objects on the left and the icons of the objects in each category on the right. Choose a category; the wizard displays the icons of the objects in that category.

ATL Objects 

· Simple Object adds a minimal COM object. 


· Add-in Object adds a COM object that extends the Visual C++ shell with your own toolbar button and event handling. This object offers the same functionality as the one added by the DevStudio Add-in Wizard on the Visual C++ File menu, New Projects tab.


· Internet Explorer Object adds an object that supports the interfaces needed by Internet Explorer, but without support for a user interface.


· Active Server Component adds an object that can be used by the Active Server Pages feature of Internet Information Server (IIS).


· MMC SnapIn creates a framework for a Microsoft Management Console Snap-In object. 

· MS Transaction Server Component includes the header files needed by the Microsoft Transaction Server and defines the object as nonaggregatable.


· Component Registrar Object adds an object that implements the IComponentRegistrar interface. This object can be used to register any objects in your in-process server that declare the DECLARE_OBJECT_DESCRIPTION  macro. Using this object you can register and/or unregister objects individually, unlike DllRegisterServer and DllUnregisterServer which register and unregister all objects in your server. You may also get a list of objects in the server and their descriptions with the IComponentRegistrar::GetComponents method. 

ATL Controls 

· Full Control adds an object that supports the interfaces for all containers. 


· Lite Control adds an object that supports the interfaces needed by Internet Explorer, including support for a user interface. 


· Property Page adds an object that implements a property page.


· Composite Control adds a control that can host many other controls.


· HTML Control adds a control with DHTML functionality and displays an HTML web page in its user interface.


· Lite Composite Control adds a composite control that can host other controls, but it supports only the interfaces needed by Internet Explorer. 


· Lite HTML Control adds a control with DHTML functionality and displays an HTML web page in its user interface, but it supports only the interfaces needed by Internet Explorer. 

ATL Miscellaneous 

Dialog adds an object that implements a dialog box. 

Data Access

· Provider adds code to support OLE DB provider templates.


· Consumer adds code to support OLE DB consumer templates. 

Double-click the control or object you want to insert. The ATL Object Wizard displays a dialog box showing options that apply to your object or control.

In the Names page, enter class and file names. By default, the name you enter for Short name becomes the root for all other names in this page. You can enter your own names 

rather than accept these defaults. 

· Class is the name of the class implementing your object.


· CoClass is the name of the component class that contains a list of interfaces supported by the object.


· Interface is the name of the interface you create for your object. This interface contains your custom methods. For Full Controls, Internet Explorer Controls, Simple Objects, Internet Explorer Objects, Add-in Objects, Active Server Components, and Microsoft Transaction Server Components, the wizard creates an interface with the name you specify. For Property Page objects, no custom interface is created, and the wizard assigns IUnknown as the object interface. Dialog objects do not create an interface. 


· Type is a description string for the object that goes into the registry.


· ProgID is a name that containers can use instead of the CLSID of the object. 

In the Attributes page, select a threading model, interface type, and aggregation support: 

· Choose Dual Interfaces if you want the object’s interfaces to derive from IDispatch as well as support your custom functions (the vtable has custom interface functions plus late-binding IDispatch methods). This allows both COM clients and Automation controllers to access your object.


· Choose Custom Interfaces to derive the object’s interfaces from IUnKnown(the vtable has custom interface functions and not IDispatch methods). A custom interface can be faster than a dual interface, especially across process boundaries.


· Choose Only for aggregation if you want the object to be instantiated only if it is being aggregated.


· Check the Support ISupportErrorInfo check box to have your object implement the  ISupportErrorInfo interface for error reporting.


· Check the Support Connection Points check box to add support for connection points to the object. The wizard will automatically derive the object’s class from  IconnectionPointContainerImpl.

· Check the Free Threaded Marshaler check box to create a free-threaded marshaler object to efficiently marshal interface pointers between threads in the same process. 

In the Miscellaneous page, choose the features for the object. 

· Choose Opaque to make your control completely opaque, so that none of the container shows behind the control boundaries. This helps the container draw the control more quickly. The entire control rectangle passes to your control class’s OnDraw method. This option sets the VIEWSTATUS_OPAQUE bit in the VIEWSTATUS enumeration.


· Choose Solid Background to make the control’s background a solid color and not a pattern. This option is meaningful only if the Opaque is option is also selected. This option sets the VIEWSTATUS_SOLIDBKGND bit in the VIEWSTATUS enumeration.


· Choose Invisible at runtime to make your control invisible at run time. You can use invisible controls to perform operations in the background, such as firing events at timed intervals.


· Choose Acts like button to enable your control to act like a button, in particular to display itself as the default button based on the ambient property DisplayAsDefault.

· Choose Acts like label to enable your control to replace the container’s native label.


· Choose Add control based on to superclass one of the standard window classes. The drop-down list contains window class names defined by Windows. When you choose one of these, the wizard adds a CContainedWindow member variable to your control’s class. CContainedWindow::Create will superclass the window class you specify.


· Choose Normalize DC to have your control create a normalized device context when it is called to draw itself. This standardizes the control’s appearance, but is less efficient.


· Choose Insertable to have your control appear in the Insert Object dialog box of applications such as Microsoft Word and Microsoft Excel. Your control can then be inserted by any application that supports embedded objects through the Insert Object dialog box.


· Choose Windowed Only to force your control to be windowed, even in containers that support windowless objects. If you do not select this option, your control will automatically be windowless in containers that support windowless objects, and automatically be windowed in containers that do not support windowless objects. 

In the Stock Properties page, select the stock properties you want the object to support, such as Caption or Border Color. You can select all the stock properties at once by clicking the  button.

In the Strings page, enter names for the property page object. 

· Title is the text that appears on the property page’s tab.


· Doc String is a text string describing the page. The property frame could use the description in a status line or tool tip. The standard property frame currently does not use this string.


· Helpfile is the name of the associated help file. The help file name should be the simple name without a path. When the user presses Help, the frame opens the help file in the directory named in the value of the HelpDir key in the property page registry entries under its CLSID. 

In the Add-in page, choose features for the Add-in object. 

· Provide Toolbar creates a toolbar button the user can click to carry out a command added by your Add-in object.


· Command Name is the name of the command added to Visual C++ by your Add-in object. This name appears in the list on the Add-ins and Macro Files tab of the Tools menu, Customize option.


· Method Name is the name of the method that implements the command. 


· Toolbar Text is the text that you want to appear on the button you add to the toolbar to carry out your command.


· Status bar Text is the text you want to appear on the status line when your command is executing.


· Tooltips Text is the text you want to appear in the tooltip message for your toolbar button when the user’s mouse hovers over the button.


· Application Events allows your Add-in object to catch application events.


· Debugger Events allows your Add-in object to catch debugger events. 

In the ASP page, choose features for the Active Server component. 

· OnStartPage/OnEndPage, checked by default, adds the OnStartPage and OnEndPage methods to the object.


· If OnStartPage/OnEndPage is checked, you can choose which Intrinsic Objects you want to have available as member pointers in the object’s class. By default, each intrinsic object is checked. 

In the MTX page, choose features for the Microsoft Transaction Server component. Dual and Custom choose the kind of interface implemented, and Support Connection Points adds support for connection points. These options are the same as the ones in the Attributes page for other kinds of objects. In addition, the MTX page has two unique options: 

· Support IObjectControl provides access to the three IObjectControl methods: Activate, CanBePooled, and Deactivate.


· Can be pooled tells the Transaction Server run-time environment that your object should be returned to an instance pool after deactivation, rather than destroyed. This option cannot be selected unless the Support IObjectControl option is also selected. 

Adding a New Interface to an Existing Object or Control :

When you add an interface to your object or control, you create stubbed-out functions for each method in that interface. In your object or control, you can only add interfaces currently found in an existing type library. Also, the class in which you add the interface must implement the BEGIN_COM_MAP macro.

There are two ways to add a new interface to your control or object: manually and via ClassView.

To add a new interface manually 

5. Add the definition of your new interface to the IDL file. 
Derive your object or control from the interface. 


6. Create a new COM_INTERFACE_ENTRY for the interface. 


7. Implement methods on the interface. 

To use ClassView to add an interface to an existing object or control 

1. Make sure that your workspace is visible by selecting Workspace from the View menu.


2. In the Workspace, select the ClassView tab.


3. Right-click on the class name of a control, for example, a full control or composite control, or any other control class that implements a BEGIN_COM_MAP macro in its header file. You will see a pop-up menu with the Implement Interface... option.


4. Select the Implement Interface... option to display the Implement Interface dialog box.


5. If there is a new interface in your project’s type library, you will see the interface displayed in the Interfaces list. You can also click AddTypelib... and select one or more type libraries from the Browse Type Libraries dialog box.


6. Select interfaces from the available type libraries in the Implement Interface dialog box and click OK. This process adds a TLH file to your project directory for each object in which you selected one or more interfaces. 

Making an ATL Object Noncreatable :

You can change the attributes of an ATL-based COM object so that the automation client cannot directly create the object. In this case, the object would be returned via a method call on another object rather than created directly.

To make an object noncreatable 

8. Remove the OBJECT_ENTRY for the object from the ATL object map.


9. Add the noncreatable attribute to the coclass. For example: 

[

uuid(A1992E3D-3CF0-11D0-826F-00A0C90F2851),

helpstring(“MyObject”),

noncreatable

]

coclass MyObject

{

[default] interface IMyInterface;

}

3.Fundamentals of ATL COM Objects

The following illustration depicts the relationship among the various classes and interfaces used in defining an ATL COM object.
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ATL Structure 


ATL implements IUnknown  in two phases: 

· CComObject , CComAggObject , or CComPolyObject  implements the IUnknown methods.


· CComObjectRoot or CComObjectRootEx  manages the reference count and outer pointers of IUnknown. 

Other aspects of your ATL COM object are handled by other classes: 

· CcomCoClass  defines the object’s default class factory and aggregation model. 


· IdispatchImpl  provides a default implementation of the IDispatch   portion of any dual interfaces on the object. 

4.ATL Window Classes
ATL contains several classes that allow you to use and implement windows. These classes, like other ATL classes, provide an efficient implementation that does not impose an overhead on your code. 

· CWindow allows you to attach a window handle to the CWindow object. You then call CWindow methods to manipulate the window.


· CWindowImpl allows you to implement a new window and process messages with a message map. You can create a window based on a new Windows class, superclass an existing class, or subclass an existing window.


· CDialogImpl allows you to implement a modal or a modeless dialog box and process messages with a message map.


· CContainedWindow is a pre-built class that implements a window whose message map is contained in another class. Using CContainedWindow allows you to centralize message processing in one class.


· CAxDialogImpl allows you to implement a dialog box (modal or modeless) that hosts ActiveX controls.


· CSimpleDialog allows you to implement a dialog box (modal or modeless) with basic functionality.


· CAxWindow allows you to implement a window that hosts an ActiveX control.


· In addition to specific window classes, ATL provides several classes designed to make the implementation of an ATL window object easier. They are as follows:


· CWndClassInfo manages the information of a new window class.


· CWinTraits and CWinTraitsOR provide a simple method of standardizing the traits 

of an ATL window object. 

5.connection Points

A connectable object is one that supports outgoing interfaces. An outgoing interface allows the object to communicate with a client. For each outgoing interface, the connectable object exposes a connection point. Each outgoing interface is implemented by a client on an object called a sink.
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Each connection point supports the IconnectionPoint interface. The connectable object exposes its connection points to the client through the IconnectionPointContainer interface.

                      6.ATL Services

 To create your ATL COM object so that it runs in a   service, simply select Service from the list of server options in the ATL COM AppWizard. The wizard will then create a CServiceModule class to implement the service.

The first four sections of this article discuss the actions that occur during execution of CServiceModule member functions. These topics appear in the same sequence as the functions are typically called. To improve your understanding of these topics, it is a good idea to use the source code generated by the ATL COM AppWizard as reference. These first four sections are:

· CserviceModule::Start

· CserviceModule::ServiceMain


· CserviceModule::Run 


· CserviceModule::Handler 

The last three sections of this article discuss concepts related to developing a service: 

· Registry Entries for ATL services


· DCOMMCNFG

When the ATL COM object is built as a service, it will only be registered as a local server, and it will not appear in the Control Panel’s list of services. This is because it is easier to debug the service as a local server than a service. To install it as a service, you must run the following at the command prompt:

YourEXE.exe /Service


             CONCLUSION 
Using  Active Template Libraries  we can develope  complex applications easily & effectively.Using ATL’s 

We can develope controls.COM objects &COM classes can

be created using  ATL’s.ATL’S differ from MFC in many ways as we explained earlier. 
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